Banding Data Entry Program Procedures: Terrestrial Division Offsites
- Written March 2004, updated February 2006, DH

These directions are modified from the Palomarin-specific directions in the Palo Handbook in an attempt to make them
apply specifically to off-sites and to reflect the substantial changes to the banding program done prior to the 2004 field
season. They include details project leaders and supervisors will need to know, and step-by-step instructions (updated in
2006) they will need to do in order for all the files to be set up correctly for the revised program.

A. Step-by-Step Instructions to Set Up the Banding Program (to start out the season on the right foot!)

O Folder Location. Make sure that all the banding files and programs that you will be using this year are located in
the same folder, and NOT in the same folder as last year’s data. Remember that the primary data files from the
previous year (band, nethrs, nethrsbynet, weather) should not only be located in a folder labeled with that year, but the
files themselves should be renamed to reflect that year and the project (e.g., clerband05.dbf).

O Versioning. Be sure you have the latest version of the banding program and all associated files. If you are at all in
doubt, received word that the program or tables have changed at all, or had any problems last year with the program,
download “Programs & Tables” (under Programs) from http://www.prbo.org/tools/band/band.htm. If you are re-
downloading the file, be sure to put the downloads in a separate folder from last year’s original data, as some of the
databases files which will share the same name as the ones in the download file, so that you don’t overwrite any data
that you need! This way you can also append into the new files data from the previous year as needed (see below)
because you won’t have lost/overwritten that data. This even applies to some of the “accessory” (i.e., non-primary)
files so to be safe just put everything from last year into a separate folder, don’t just pick and choose the files to
organize this way. Also, please remember that there are numerous files associated with the banding program aside from
the ones you know about that are used in the proofing process, so you want all files that come with the download.

O Setting Exact On. Under Tools > Data > Check the box for SET EXACT ON (otherwise, e.g., if you are trying to
look up initials="DJ” and someone else’s initials “DJT” are also in your table, both will be included). This can cause
much bigger problems than just thinking you’ve banded more birds than you have! Note that you can set exact off or
on from the command prompt as well — sometimes it’s convenient to have it off — be sure you know how it’s set, and if
you set it off, be sure you understand what that means (refer to Foxpro help for more information).

O Setting Century On (so year=4 digits). Under Tools > International > Check the box for SET CENTURY ON.
Otherwise your dates will be messed up in some date entry processes, because if you can only enter the year as 2 digits
instead of 4, then the full year will default to being 19xx not 20xx. If you have done such data entry without
CENTURY set on to any tables (or are working on tables from the 1990°s which were mostly done this way), you need
to run the Y2K program (if you don’t have it, it is stored on the procedur folder on the Palomarin server) to very easily
and quickly fix this.

O Shortcut. You may want to create a shortcut of band.exe to your desktop. If you have done this in a previous year,
you will want to erase that shortcut and redo it in case it is connected to a banding program in the incorrect folder.

O FoxPro Familiarity. Download and read “Visual Foxpro Tips & Tricks” word document before you proceed to
troubleshoot possible problems you might encounter in this and other programs during setup and during the season
(http://www.prbo.org/bbs/viewtopic.php?t=296, or if you have trouble with that URL go to Forum index >»

PRBO Bulletin Board Topics » How To's and Policies » Computer Help

O Monitor Interface Problems. Problems viewing the banding program data entry interface on your monitor ? If not
all of the screen is visible (e.g., the bottom is cut off and inaccessible), or simply to preempt this, you must change your
display settings by doing the following: go to control panel->display >settings, and change the screen resolution to be
at least 1024x768.

O Familiarity with Databases. Open up the banding program (band.exe) and see the Utilities menu pulldown option
for a description of primary databases used in this program. There are more than you might think...



O Emptying Out the Primary Databases. This is done at the beginning of the season/year. Before you do this,
remember that where you are going to enter your data in the current year should not be the same folder where you are
saving data from a previous year. Be sure you have backed up / moved the files you want saved before you proceed.
To begin your year, the following should be empty: a) mist.dbf, b) band.dbf, ¢) allnumb (yes, allnumb), d)
weather.dbf, e) nethrs.dbf, and f) nethrsbynet (see below for details on whether or not you want to use the latter
database). The ones that are downloaded from the website should be empty but check just in case that’s not the case.
To empty out a database, see “FoxPro Tips & Tricks” (or just hit zap!).

O Set up vour historic database (the clean, updated file that will not include the current year). Important note:
this is separate from allnumb. The purpose of this database file is to have all your data from previous years in a single
location, and it is to that database file that you will make changes when you find mistakes in historical data. This is
your clean database. You can name your historical database whatever you want, e.g., at palo we call it allbandpalo.dbf.
Your historical database should ideally be accessible from the banding computer where you conduct your banding data
entry, although it is not required to be in the same folder as your other banding data. If you make any changes to the
historical database, you may need to access it from the banding computer in order to recreate allnumb. If you’ve
already created this file in a previous season, at the beginning of the new season you generally will need to add the
previous year’s data to this historic database by appending from the final banding database for that year if you haven’t
already done so, so that it’s complete (e.g., use allbandpalo.dbf, append from paloband2005.dbf). Important note:
Never create this database from allnumb, because allnumb does not have all the fields that are in band (e.g., notes
field) so you will lose data.

O Setting up allnumb (reference file). You will need to create a project-specific allnumb, which is used by the
program as the reference database file during the proofing process and when looking up the capture history of an
individual. You may also choose to access it manually as your own reference database during the season, as although it
doesn’t have certain fields (e.g., is missing the notes field), it contains data from all years including the current year
which is convenient. Follow these steps: 1) Make sure you have the current version of allnumb (that comes with the
program when you download it). 2) Make sure that it is empty and if not, empty it out of all data. 3) Go into the
banding program (band.exe). 4) Under Utilities, Choose “Rebuild Allnumb from band and historic data”. 5) Select
your properly updated historic database (see above). 6) Select your current (and which should be empty!) band
database for the current year. At this point allnumb will look like your historic database file but with fewer fields;
however as the season progresses, the current year’s banding data will be automatically added to allnumb.dbf when
you finalize your banding data after proofing and making corrections.

O New banding location? If you are adding banding locations (constant effort, nest plots, target netting or other) this
year, double-check with Diana that the 4-letter code you wish to assigned the location is unique within the Terrestrial
Program. Also see the bulletin board under Science > Banding Topics for the information you will need to get to her
on the new site before she can schedule your data. After you’ve checked with her on the code, you should then do one
of two steps: 1) add this 4-letter code to the mastrloc.dbf that is in your band program folder, or 2) ask Diana to send
you an updated mastrloc.dbf; otherwise you will get an error every time you proof the data for that location. Please
note: the mastrloc.dbf you have on your computer, especially if downloaded in a previous year, is not necessarily the
most updated version for the entire Terrestrial Division, so you cannot look at it yourself to determine what new 4-
letter code you can use. Also, if you added banding locations the previous season, you will indeed want to download
the banding program and files in order to get the updated mastrloc.dbf (or just ask Diana to send that to you) so that
you don’t get an error every time you proof data for that code.

O Decide About Tracking Individual Net Hours The Individual Nets function and database (nethrsbynet.dbf)
allows you to track net hours for each individual net — information including in the “notes” field of the nethours.dbf if
you do not use this function. This may be useful for all projects, but especially at banding sites where nets may be
placed in more than one habitat type or analysis may be done using individual net data. This is also useful for any
projects submitting breeding season banding data to MAPS, as they request individual net data for their records and
analysis. Especially if your project does not contribute to MAPS, supervisors can decide if they want to do this for
their project or not.

O Prepare for Tracking Individual Net Hours If you are going to be entering the individual net data, you will need
to add your sites to the netsbyloc.dbf table which you are provided, if they are not already there from a previous




season. If you have done this in a previous season but had to download the program and files for some reason (see
above), it will be easier to find that database and append the data into the current year’s netsbyloc.dbf, rather than to
recreate it. You will enter a record (line of data) for each net at each site. For instance, if you have 10 nets and they are
numbered 1-10, you will have a line of data for each net, with the project and location (4-letter code) fields filled in,
and then the net number under “netname”, and the number of nets that correspond with that number under “numnets”
(e.g., most nets will have a “1” under numnets, but at Palomarin our double-stacked nets will have a “2” there). The
database you download will have Palo data in there already, but this will not affect you so you do not need to zap it
unless you wish to.

O Add to netnames.dbf if you have unusually numbered nets. The banding program will give you an error if you
use net names other than 1) nets 1-20, or 2) the Palo net numbers that are listed in netnames.dbf. If you use unusual
net numbers (e.g., 40) and wish to avoid getting errors when you do so, simply add the number to netnames.dbf. Do
not do this for nestids or “TN” (target net) as it cannot accept character fields here (but can when you actually enter the
banding data).

B. ENTERING DAILY BANDING DATA (to be done the day it is collected!)
Any bird that receives a line of data must be entered into the banding computer. It is essential that this data entry be done
daily. The longer one waits to enter data the poorer the quality of data.

1.
2.
3.

4.

5.

6.

Use the same banding computer for all banding data entry for a project.

Choose the Visual FoxPro shortcut to band.exe icon on the desktop or in the correct folder.

Select the Data option from the menu

Weather:

a. Select Enter Weather Data

b. Hitthe Add button.

c. Enter any weather data not yet entered. At Palomarin, do not enter the current day’s weather until the following
day to ensure that the low temperature is correct, as temperatures could drop by midnight lower than they were in
the morning. For project enter your standardized project name (e.g., Lassen, Cosumnes, etc.). Your project name
should match across all databases (i.e., if you’re using “Lassen” in the banding databases, you should also use
“Lassen” in the nesting and point count databases.)

d. Hit the Exit button when finished.

e. Be sure to mark the raw data as entered (with a horizontal red line next to each record).

Net Hours:

a. Select Enter Net Hours Data

b. Hitthe Add button.

c. Enter date, loc, banders (enter the whole name and not just initials for volunteer banders), time of opening and
closing of nets, total net hours, and notes. The additional notes should always include an explanation for any nets
that were not run the entire time.

d. If your supervisor does not need you to enter individual nets for this project, hit the Save button and continue to
section i. below.

e. Otherwise, hit the Individual Nets button to go to the next screen. Do this even if you had a complete banding day
or if all of your nets that closed early were closed simultaneously.

f.  Hit Add Net Rows to import records for your date and location of banding. Do this even if you had a complete
banding day or if all of your nets that closed early were closed simultaneously.

g. Ifyou had a complete banding day or all nets were closed at exactly the same time, hit Save (on both screens) and
Exit now.

h. If not all nets were open for the same exact period of time, scroll between nets using the Next Row and Previous
Row buttons. When a net is shown for which you had less than a complete day, modify the open, close, and hours
times accordingly. If all of your nets closed early and at the same time, after you have added net rows you may
exit.

i.  Hit the Save button (on both screens if prompted twice) and then Exit when finished.

j.  Besure to mark the data from the net hour sheet as entered (with a horizontal red line next to each record).

Banding Data:
a. Select Enter Banding Data
b. Hitthe Add Button



c. Please enter all data for birds netted that day.

d. Type in all fields for each record, and mark each entered record in the raw data with a horizontal red line.

e. The tab and return keys can speed navigation within the banding data entry screen. Tab moves forward one field or
button, shift-tab moves backwards one field or button, and Return selects the “default” command button. When
finished with one record and ready to add the next record, for example, hitting Return twice and then Tab twice
will save your current bird, begin adding a new bird, and navigate to the first field of the new bird._If your last
field you were in was the Notes field, the Return key doesn’t work from there so you must first tab out of the
“notes” field before hitting Return twice and then tab twice.

f.  When completed with all records, hit Save and Exit buttons.

g. On the following page is a list of data fields and corresponding notes. For the most part they are the same as
banding data sheet. PLEASE RECORD 9 FOR DATA NOT TAKEN.

Field Name Description of Banding Data Entry Type

SIZE Band size = 0,X,1,2,3,etc. Use RE for recaps.

INITIALS Bander’s initials

CODE Band code, i.e. N =new, R =recap, U = Unbanded, C= Changed, L = lost, D = Destroyed.

BANDNUMB Enter complete band number: if not banded enter a 0. If hummingbirds are banded, replace the
alphabetic code with the numbers it represents (Y = 3000, etc).

SPEC 4 letter AOU code

AOU Enter 4 number AOU code

AGE 0,1,23456,7

HA1l How aged? J,H,AW,C,B,l S,T,E,F,M,P,R, X, V or 9

HA2 How aged? J,H,AW,C,B,I,S,T,E,F,M,P,R,X, V or 9

SEX. M,F, or U

HS1 How sexed? J,H,A,W,C,B,1,S,T,E,F,M,P,R, X or 9

HS2 How sexed? J,H,A,W,C,B,I,S,T,E,F,M,P,R, X, or 9

SKL Skull pneumaticization (0-6)

BRP Brood patch:0,1,2,3,4

CLP Cloacal protuberance:0,1,2,3

FAT Fat:0,1,2,3,4,5,6,7

MLT Body molt: 1, 2, 3

FFM Flight feather molt; 0 (absent), F (flight feather molt), or A (adventitious molt)

WWR Wing wear: 1,2, 3, 4,5

FDL Fade line: 1, 2, 3

WING Unflattened wing chord length, in mm

WGHT Weight, in grams

STAT 000 if not banded, 300 if USFWS band only, 301 if color banded, 615 if severely injured (and
banded), 636 if held in captivity, 008 if a marked hummingbird.

DATE mm\dd\year

TIME 3 numbers only rounded to the nearest 10 minutes, using 24-hr time. (1:15pm become “131”)

LOC 4 digits for locations of all offsites (e.g., TAFO, GUCR)

SITE Net number, nearest single grid point, nestid (e.g., 01A), or target net (“TN”)

TCR Tail or crown measurement, in mm. For OCWAs and WIWAs whose crowns did not get
measured be sure to enter “999”. If crown = 0 be sure to enter it; do not just leave it blank.

TAR Tarsus length, in mm

NEWCB If this is a changed colorband combination ,or the first time the bird is color banded, use "T" for
true. Otherwise "F' for false

COLORS Color band combination (e.g. 0S/O0)

INJ Injury codes - see above or list under Utilities menu in banding program

RES Was injured bird released? Treated? See result codes above or in Utilities menu in program

COM Put a "T" for true if there are notes on back, and if not, “F” for false

PROJECT Enter appropriate project (“Palomarin” for all west Marin sites)

OLDBAND # of the band that was removed from the recapture if the band was changed.

NOTES Enter all notes from backside of sheet. Tail length, tarsus measurements, color combinations,
etc can be entered in the appropriate fields and do not need to be double-entered.
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DAILY PROOF: PROOFING AND CORRECTING BANDING DATA (to be done the same day the data was
collected and entered)

Before printing out proof, select Run Recap Report under the Proof menu. This allows you to see if there have been

any erroneous current or prior data discrepancies for all recaptures for which data has been entered.

a. If you find that the data collected that day is incorrect, please make changes on the raw data sheet and in the
current banding data (using the View/Edit/Make corrections option under the Proof menu or by going into the
mist.dbf). Except for species discrepancies, change the incorrect data to unknown; do not change it to what it was
determined on another date.

b. If you find that the historical data from the current year is incorrect, please make changes in the raw data and in
band.dbf (choose by selecting Open under the File menu). Except for species discrepancies, change the incorrect
data to unknown; do not change it to what it was determined on another date. You do not need to make these
changes to allnumb, as all the current year’s data in band.dbf will be added to allnumb when you do the “finalize
and backup” step below.

c. Ifyou find that data from previous years is incorrect, please see your supervisor about the process of correcting the
historical data. Each project may have a different system, but most likely you or they will make the corrections to
a file that contains all previous year’s data and NOT the current year’s data (it might be called something like
allbandlassen.dbf). DO NOT make corrections to allnumb as that is ONLY a reference file and does not
contain all the data fields. Often your supervisor will prefer to make all these changes his or herself and will ask
you to keep a running tally of the changes that need to be made to historic data.

d. The supervisor should email me regarding any resolved historical errors, as | will need to make these changes to
our main banding database (allband.dbf) for all projects that is housed at Palomarin. In the future they will likely
be able to access an online database and make these changes themselves.

e. Your supervisor will generally want to occasionally recreate allnumb (every month or so such as after the monthly
proof is completed, or after they have made any changes to historic data). This is done by going into the band
program (band.exe) and choosing, under the Utilities menu, “Rebuild allnumb from band and historic project
data”. This updates allnumb.dbf so that all the mistakes you just fixed in your historic or current database are
reflected in that database as well, without you having to manually make those changes in multiple databases.
Choose your historical database (e.g., allbandlassen) when it asks you to select your historical database, and
“band.dbf” when it prompts you for your current database.

Select Proof/daily proof from the menu.

At the prompt for printing the proof, put legal size paper in the printer, and select “yes”.

Always proof the data with two people, with one person reading out loud from the raw data and a second person

simultaneously looking at the printout for errors. Thoroughly check all error codes, which might mean sifting through

old data. A listing of error code meanings can be found under the Utilities Menu. (See Helpful Computer Hints at
the end of the Palo Handbook, or Foxpro Tips & Tricks (on the bulletin board) for Foxpro commands and ways to
look up old data).

Using red ink put a vertical line through the first slash on the raw data sheet, making a “+”, to show it has been

proofed. On the printed page put a horizontal line if there were no mistakes, and a circle and if there are mistakes. If

there are mistakes change the data in red on the printed page.

Make corrections in the FoxPro banding program under Proof then View/Edit/Make Corrections, or by selecting and

opening Mist under the File menu. Put a check mark next to each corrected mistake on the printout so you know it has

been fixed.

Write “entered/proofed/corrected”, the date, and your initials on top of the proofed computer-printout.

After all corrections have been made from the daily proof, choose “Nonpalo finalize and backup” to save the data.

This makes backups and moves the banding data from mist.dbf into band.dbf and allnumb.dbf.

Note: if you come up with an error for your location not being valid but you know that it is the correct 4-letter code for

that station, you should then do one of two steps: 1) the project supervisor/project leader should add this 4-letter code

to the mastrloc.dbf you are using as part of your program, or 2) ask Diana to send you an updated mastrloc.dbf and tell
her which location code is causing the problem.

. MONTHLY PROOF (to be done after all the data for a month has been collected, entered, proofed, and corrected, and

finalized; in this process we completely proof all the data again - and we still find mistakes! At off-sites this may be
done at the end of the season, but this second proofing process is highly recommended!).

Make sure the correct paper is loaded into the printer.
In the band program, select Proof then Monthly proof. When you are prompted, select “yes” for Monthly proof
(banding data), Net Hours, and Weather.



Proof the data using the same exact process you use with the daily proof - reading off the raw data; and checking the
computer generated error codes for the banding data.

Once a line of banding data has been monthly proofed, the “+” sign next to it should be circled. For net hour and
weather data, for which this is the first proofing process, make a "+" sign out of the "-" on the raw data sheets.

Once proofing has been completed, check all raw data as well as the entire printout to be sure that all lines of data have
been proofed.

Make corrections by choosing Open under the File menu, and then selecting the appropriate database (band.dbf,
nethrs.dbf, or weather.dbf) where you need to make corrections. Find your record that you need to edit and correct it.
After all corrections are made, go into the band program (band.exe) and choose, under the Utilities menu, “Rebuild
allnumb from band and historic project data”. This updates allnumb.dbf (which is used in the proofing process) so
that all the mistakes you just fixed in your historic or current database are reflected in that database as well, without
you having to manually make those changes in two separate databases. Choose your historical database (e.g.,
allbandlassen) when it asks you to select your historical database, and “band.dbf” when it prompts you for your current
database.

To make a backup of your updated band.dbf, select, under the Proof menu, “Nonpalo Finalize and Backup”.

Write “entered/proofed/corrected”, the date, and your initials on top of the proofed computer-printout.




